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Introduction 
Whether you gather customers around a conference table or sit down for a one-on-one, bring Morae along to 
capture the interaction and share the results quickly and powerfully. 

Type notes and flag important moments as Morae records video from up to two cameras. Team members or 
stakeholders can watch the live video stream…and log their own observations. Everything is captured digitally 
on your hard drive—no videotape to transfer, no hand-written notes to type up. 

As soon as the session is over, quickly search back through the notes and markers, select the best clips, and 
export your highlight reel directly to PowerPoint. Faster turnaround—better results! 

For focus groups, Morae can record from one or two cameras. With two cameras, you can record a wide 
angle of the complete focus group, along with close up camera video of specific participants.  

This document provides the following: 

 Focus Group Basics 

 Set Up the Focus Group  

 Record and Log Focus Group Sessions 

 Analyze and Present Findings 

The document also contains Appendix A: Focus Group Summary Outline, which you can use as a 
template to put together a Summary Report. 
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Focus Group Basics 
Focus group research helps you gain deeper understanding of attitudes and beliefs of representative groups 
of people - often customers or prospective customers - by asking them to have a conversation about your 
product. Focus groups help researchers and marketers gain insights into stakeholder groups’ wants and 
needs, develop additional research tools, and make truly informed decisions on the design of products and 
services. 

Focus groups start with a proposal or work statement that defines: 

 Research goals 

 Strategy 

 Research methodology (how many focus groups, how many participants, where and when) 

 Research methods to be used (conversation, simulation games, direct product contact, etc.) 

 Sampling methods and participant qualifiers  

 Incentives you plan to provide for participation 

 How your findings will be analyzed and delivered 

Recruit Participants 
To recruit focus group participants, you may find it helpful to use client lists, internal databases, or email 
contacts. You might use a Web ad or use a professional recruiting agency to assemble an appropriate sample. 
An effective focus group sample has a maximum of ten participants. 

 Create a screening device to help you recruit the right sample. You want to reflect your target population 

as close as possible. You may be looking for a particular age, gender, type of consumer, or other 

qualification.  

 As you schedule your groups, you may wish to segment your groups by demographics (age, gender, 

education, etc.), types (power users and new users, Ford or Chevy owners, etc.) or mix them, depending 

on your research objectives. 

 As your recruits agree to participate, send them a letter and/or an email with the specifics of location, time, 

and date. Include a map and give them a phone number to reach you. 

Morae Configuration 
You can use Morae to capture your focus group sessions. The Focus Group template in Morae Recorder 
includes all of your markers and camera settings needed, and you can tweak the template with your own 
settings.  Remember to think about camera angle, microphones and lighting. A trial run will help you identify 
problems and get everything ready.  

Create a moderator's guide for each focus group session.  Include open-ended questions designed to 
stimulate conversation and to keep the conversation flowing smoothly. The questions should help you gain 
qualitative data for your research objectives: Key words and phrases for additional survey research.  

If you use an observer to help you take notes, give the observer a copy of the guide and discuss in advance 
what you would like the observer to note, including interesting quotes or moments of conversation. 
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Conduct the Focus Group 
Set up your camera(s), recording equipment, and any additional props or tools you might need during the 
conversation. Seat participants and ask them to sign an agreement to be recorded, and make sure they are 
comfortable. 

The moderator asks questions and writes notes on white board/paper to capture everyone’s comments and 
guide the conversation. The moderator may also take notes in the moderator guide.  The observer should 
make notes using markers in Morae to flag reactions, emotions, and interaction with the product and among 
participants. 

Tips for great focus groups: 

 Give the group a warm up exercise to get to know each other.  

 Reviews basic instructions and your goals.  

 Keep everyone talking; avoid letting one person dominate.  

 Use the reflection technique to clarify statements and to further stimulate the conversation and flow of 

ideas: ―What I hear you saying is….‖ And ―so, what you’ve just told me…‖ 

 Remember to thank your participants and provide them with their incentive when they leave. 

Take Notes 
Your observers can be a key to capturing great video. The observers log notes from any location on the 
network using Morae Observer, or can simply make notes on a laptop using moderator's guide as a script.  

The observers type as much detail as possible. In Observer, use a predefined Quote marker to note the spot 
where a participant makes a particularly good statement.   

Your observers may note that recurring messages or themes. Ask your observer to categorize themes or 
trends as they become apparent. The moderator can make notes that can be tagged with a marker. 

Debrief 
At the end of the day, ask your staff and stakeholders to meet and discuss what you’ve seen and heard. Ask 
your clients - what did they see, what were the surprises, what else needs to be explored? 
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Report Findings 
There are several ways you may want to present your findings: 

 Top line report 

 High level bullet report – you don't need much detail. 

 Identify trends, themes and answers to the objectives of the research. 

 Identify surprises or unexpected comments. 

 Comprehensive summary report  

 Review the material in more depth.  

 Include specifics and detail. 

 Objectives  

 Goals  

  Table of participant segments  

 Your script and the incentives offered 

 Presentations 

 Other deliverables, such as DVD recordings of full sessions 
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Set Up the Focus Group 
Use the steps in this section to set up the study in Morae Recorder for a focus group. For more information on 
focus group planning, see Focus Group Basics. 

 

To set up a test in Recorder: 

1. Create a Study Configuration 

2. Define Questions  

3. Define Markers 

4. Save Study Details 

5. Configure Recording Details 

6. Complete Focus Group Set Up 

 This document walks through this process at a high level. You can find more information on the full 
procedures and options in the help included in the Morae components or find both video and written 
tutorials in the Morae Learning Center: http://www.techsmith.com/learn/morae/default.asp.  

http://www.techsmith.com/learn/morae/default.asp
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1. Create a Study Configuration 
A study is a group of focus groups that discuss the same topics. In Morae, a study configuration file (.mrcfg) 
defines all study-specific information. This includes the tasks (questions) and markers. 

Use the same study configuration to record each of the focus group sessions. Only recordings with the same 
study configuration can be later searched and graphed together in Morae Manager.  

Morae Recorder includes template study configurations to help you define study configurations for different 
kinds of studies. Templates contain sample tasks, markers, and surveys, along with pre-configured 
Recording Details which define how to record the session. 

When you open Recorder, create a new study configuration based on Focus Groups. When you click OK, 
the template study configuration opens in Recorder. 

 

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study 
Description > Study Instructions. 

2. Define Questions  
For a focus group, you define the questions you plan to ask during a session as tasks. 

Tasks in Morae Configuration 
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 Recorder > Modify Study Details button > Task Definitions tab 

For each question, enter a name and description.  

 

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Tasks. 

3. Define Markers 
After you create questions (tasks), then create the markers. Markers allow the observers to flag specific, 
important points in a recording and save time when you analyze the results.  

For example, mark:  

 Participant comments and questions 

 Observations about how the participants react 

 Interesting comments or actions to include in a highlight video  

You can also add notes to provide additional details for each marker. All the markers and notes are 
synchronized with the video and saved in the recording of each test session. 

Morae also includes the ability to score markers, for example 0 (negative) and 1 (positive).  
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Markers in Morae Configuration 

 Recorder > Modify Study Details button > Marker Definitions tab 

In Morae, a marker definition includes a letter (keyboard shortcut for logging), text description, and color. 
Each study configuration template includes a default set of markers. The Focus Group template includes the 
following markers:  

Q - Quote N- Note 

Use the provided default markers, modify the markers, or create new markers that match the goals of your 
study or identify specific things you want observers to watch for during a session. 

Morae Marker Tips 

 There is no correct number of markers. The object of logging markers during a focus group is to make it 
easier to analyze the results.  

 If you have specific things you want to look for in a test, create a marker for that item, comment, issue, etc.  

 Later when you analyze your sessions in Manager, markers help you sift through data and focus on what 
you want to analyze. For example, viewing all the Quote markers with negative scores may reveal where 
people are unhappy with a concept. 

 When you are ready to create video clips or a presentation for stakeholders, you save time by quickly 
going to the moments during the session that you marked as Quotes to include in the highlight video. 

 For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Markers. 

4. Save Study Details 

 File > Save Study Configuration or click the Save Configuration icon. 

Study Details must be the same for all recordings in a study and include: 

 Study name and description 

 Tasks definitions  

 Marker definitions  

By saving the study configuration, and reusing that configuration, all recordings have the same configuration 
and can be imported into the same study in Manager. 

5. Configure Recording Details 
Recording Details included in Morae study configurations define how to record the session, including the 
following: 

 File saving and processing options 

 Video sources 

 What data to capture 

 Who logs tasks 

 How to start and end test recordings 
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Recording Details in Morae Configuration 

 Recorder > Recording Details button  

The Recording Details of the template study configuration allow you to immediately conduct a recording. The 
Recording Details for the Focus Group template include: 

 Prompt for file saving details when recording stops 

 Record from a camera and optionally include a Picture-in-Picture video from a second camera 

 Log tasks with the computer running Recorder (Local Logger) 

 Start and stop recordings manually with Recorder 

 Allow Observers 

Morae Recording Details Tips 

 Recorder automatically chooses the source cameras for the main and PiP videos. Verify the selected 
sources are correct before recording. 

 If you change any Recording Details settings, the rest of the settings update to provide a valid or 
recommended configuration, if needed. 

 Recording Details are saved as part of the study configuration. While the Study Details must be the same 
for all recordings in a study, the Recording Details can vary in each recording. 

For more information, in the Morae Recorder Help, see Define Recording Details. 

6. Complete Focus Group Set Up  
Study configuration is now complete. Here are the final things to do before you start recording. 

 Create Moderatorôs Guide  

 Finalize Morae Recorder Setup 

Create Moderatorôs Guide  
The moderator’s guide is a document of everything the moderator needs to know for a focus group. The 
facilitator can use this document as a script during the session. Some of the items to include in the guide 
include: 

 Introduction 

 Guidelines for the session  

 How long the session will take 

 The topic (product, idea, etc.) of the focus group 

 All opinions are welcome 

 Explain the Release Form and have participants sign agreements 

 Ice breaker for group 

 Discussion questions 

 Closing and thank you 
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Release Form 

A release form gives permission to record the test. Morae records the video and audio of the participants.  

If permission to record is denied, you may still conduct the focus group and take notes to use in reporting 
results, but you must not record the session.  

If the contents of your test require the participant to keep session and product information confidential, include 
a non-disclosure agreement in your form. 

The example test protocol includes a sample release form that includes a non-disclosure agreement. 

Email Invitations for Observers 
Verify that all observers have Morae Observer installed. Send an email to each observer with the following 
information:  

 Name of focus group 

 Date of focus group session  

 Time of focus group session 

 IP address or name of Recorder computer 

 You may also want to include a list of the questions and markers to let the observers understand what 
they should watch for during the session. 
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Finalize Morae Recorder Setup 
Prior to a Morae test, complete the following tasks: 

 Complete the Pre-recording Checklist 

 Run a Pilot Test before Recording 

Complete the Pre-recording Checklist 

The following checklist describes critical points that reduce the technical issues you may encounter and 
improve Morae’s overall performance.  

Step Description 

Verify the system 
requirements 

Verify your system meets the recommended specifications to get the most efficient 
performance from Morae. For more information, see Morae System Requirements 
in the Morae Recorder Help. 

Verify you have 
enough hard drive 
space 

Recording file sizes may be approximately 10–15 MB per minute, but the actual size 
varies depending on many factors. You should have extra space available for the 
best performance during recording.  

As a general rule, maintain 5–10 GB of extra hard drive space as a buffer beyond 
what your Morae recording files use. 

 We recommend initially saving your recordings to a local hard drive to eliminate 
the chance of data loss that can occur when saving over a network or to an 
external device. After the file is saved, you can copy the recording file to an 
external device. 

Test your setup  Test your setup before the actual recording session to resolve any possible 
complications (such as firewalls blocking Observer(s) from connecting, etc.).  

We recommend running a pilot recording for a short period of time to test Recorder’s 
start and stop options and to verify Observer(s) can connect. For more information, 
see Run a Pilot Test before Recording. 

 In addition, use the Test Recording option in Recorder to create a 15 second 
recording to verify the camera and audio streams are being recorded properly. 

Verify Network 
Settings 

If Observer and Recorder are on the same Intranet, you do not need to disable 
firewalls. 

If they are not, verify that you either disabled any firewalls running on the Recorder 
or configured the firewalls to open the communication ports. See your network 
administrator for assistance.  

There are no firewall adjustments necessary on the Observer side.  

Open the study 
configuration in 
Recorder 

Open the saved study configuration in Recorder. 
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Run a Pilot Test before Recording 

We recommend running a pilot test to verify Recorder is capturing data as expected. Conducting a short pilot 
recording helps you work out any network connectivity issues and test your automated start and stop options, 
if applicable. Follow these steps to run a pilot test: 

Step Notes 

1. Open a study configuration. In Recorder, open the study configuration (.mrcfg) for this study.  

2. Start Recorder. Click the Start button to start Recorder manually.  

3. Connect Observers to Recorder. Connect one or more Observers during the pilot test. Verify that you 
can successfully connect each to Recorder. 

4. Complete a test task. Run through one of the tasks. To test the logging functionality of 
Observer, have a team member practice setting markers while you 
complete the task.  

5. Stop Recorder. Either stop Recorder manually by clicking the Stop button in 
Recorder or use the keyboard shortcut <Ctrl + Alt + Shift + F9>.  

6. Import the recording and run a 
search. 

Save the test recording file and import it into a project in Manager. In 
Manager, verify the audio and video recorded correctly. Use the 
Search to verify markers were captured. See Analyze and Present 
Findings for more information on how to do this. 
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Record and Log Focus Group 
Sessions 
In this section, we discuss how to record and log test sessions using Morae Recorder and Observer: 

 Observers and Logging 

 Start and Stop the Recording 

 Log the Sessions 

 Save the Recording 

Take Notes on Recorder 

When you record from one or two cameras with Recorder, you can log questions and notes right on the 
computer running Recorder. This is the default task logger setting for camera only recordings.  

Observers and Logging 
Morae Observer connects to Recorder over a network and displays the full focus group experience, including 
audio comments and camera video. Each person using Observer can log markers, marker scores, and text 
notes that are sent back to the Recorder and saved with the recording file. 

By logging questions, markers, and notes during the test session, you save time analyzing the recordings. In 
Manager, you can use the markers to pinpoint parts of the recordings you need to review, automatically 
create graphs, calculate marker scores, and more. 

Observers can connect prior to the beginning a recording, as long as Recorder is running. Observers do not 
see the camera video until recording begins. 

Benefits of Observer 

Although you can log sessions in a variety of ways, using Observer in combination with Recorder provides the 
following benefits: 

 Stakeholders can connect to watch live sessions without the need be in the room with the focus group or 
an observation room. With Observer, stakeholders can connect from anywhere on the network. 

 Anyone logged into an Observer computer can add markers during recording complete with text notes. 

 Morae automatically collects and compiles everyone’s notes. The recordings contain the markers and 
notes logged by all Observers.  

 Observer automatically saves and indexes the markers and tasks with the accompanying video and 
audio streams.  

 You can save a copy of the camera video and audio streams as a WMV file for immediate playback or to 
share with stakeholders. 

For information on connecting Observers to a recording, in the Morae Observer Help, see Connect to 
Recorder. 
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Start and Stop the Recording 
The default way to start and stop recordings is to click the following buttons: 

  

Start Stop 

If this does not meet your needs, Morae provides flexible options to automatically start Recorder depending 
on your equipment and participant set up.  

For more information, in the Morae Recorder Help, see Define Recording Details > Recording Start 
Settings and Define Recording Details > Recording Stop Settings.  

Log the Sessions 
Once recording starts, the moderator starts asking the questions.  

The person working on the computer running Recorder along with each person using Observer can log 
markers, marker scores, and add text notes to save with the recording file. The person working on Recorder 
is designated as the task logger logs questions and scores.  

With both Recorder and Observer, you can save a copy of your markers and notes as a comma separated 
values (CSV) file to import into other programs. Observers can also save a copy of the recording as a WMV 
file for immediate viewing.  

At the end of a session, the questions and scores are saved with the recording. You can view the 
synchronized video, audio, and notes for each marker later when you import the recording into Manager. 

By logging with Recorder and Observer during recording, you will save time analyzing the study in Manager. 
There should be no need to review entire recordings if you use Manager’s powerful search and graphing 
features to quickly analyze the recordings. 
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The components used when logging in Recorder and Observer are: 

 

For more information, in Morae Observer Help, see Log a Session. 

Save the Recording 
By default, when recording stops, you are prompted for file details. Enter a name and description for the 
recording. If you want to start another recording right away, in Recording Details, choose to defer the 
processing of the recording. You can later batch process recordings. 

For additional options, in the Morae Recorder Help, see Define Recording Details > File Details > 
Processing. 

 You cannot save a recording without a name. You can lose the data from a recording if the test 
participant, or anyone else, closes the dialog prompting for these details after the recording stops. 
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Analyze and Present Findings 
In this section, we discuss how use Morae Manager to analyze your recordings and create a presentation or 
report of your findings: 

1. Import Recordings 

2. Edit Recordings 

3. Analyze Recordings 

4. Create Highlight Clips 

5. Create a Summary Report  

1. Import Recordings 
To import recordings into Morae Manager, first create a Morae project. Use a project to organize the 
recordings and studies in Manager.  

You can import a single recording into multiple projects. When you import a recording into a project, the 
original recording is not touched. A copy of the recording in imported into the project. Any changes you make 
to this copy do not affect the original recording. 

You can import Morae recording (.rdg), UserVue recording (.rdg) and standard video files (.avi, .wmv, .asf) 
into a project. 

For more information on importing recordings and creating projects, in the Morae Manager Help, see Create 
and Modify a Project > Create a New Project. 

2. Edit Recordings 
View and edit the imported recordings in the Analyze Tab. In Manager: 

 Review the main camera video automatically synchronized with the Picture-in-Picture video and audio. 

 Create additional or edit the logged questions, markers, notes, and scores. 

 Search across recordings in a study for specific markers. 

For information, in the Morae Manager Help, see Analyze. 
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3. Analyze Recordings 
Manager’s Search allows you to quickly create custom searches to look for markers and tasks. Use the pre-
defined search profiles, define a new search, or create and save your own search profiles.  

 

 

For more information, in the Morae Manager Help, see Analyze > Search for Data in Recordings. 
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4. Create Highlight Clips 
When you are ready to organize the results of your analysis into a highlight video for presentation, select 
Manager’s Present tab. Use the Clip Bin and Storyboard to create, view, edit, and sort clips and graphs and 
assemble them into a video presentation. 

In the Present tab, assemble the important video clips, graphs and tasks into a highlight video to share with 
stakeholders. Include just the participant’s screen and audio in the highlight video or add a Picture-in-Picture 
(PiP) window showing the participant’s facial expressions. The highlight video can be produced in AVI, WMV, 
or MPEG-4 format. 
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After you have your highlight clips together in the storyboard, click the Produce Highlight Video button and 
select the Produce to PowerPoint option to produce the videos and send them into a PowerPoint 
presentation.  

 

For more information on creating highlight clips and options for exporting other data from Manager, in the 
Morae Manager Help, see Present. 

5. Create a Summary Report  
Appendix A is an example outline for a Focus Group Summary Report. Use this outline to help structure your 
results from the focus group sessions. 
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Appendix A: Focus Group Summary 
Outline 
Title of project: 

Prepared by: 

Date: 

Executive Summary 
At the request of (Name of Client), (Name of Company) conducted X focus groups between (dates) to explore 
(state the subject matter.) The purpose of this inquiry is (state purpose). The inquiry was focused on (state in 
general terms who participated) and is intended for (state the persons to whom this is directed.) 

Findings show (summarize findings, themes and observations) 

Introduction 
(Introduce the subject, the client, the environment and the objectives of the research.) 

Methodology 
State the specifics:  

 Who performed the research 

 Who was researched (how many of what types of participants) 

 How participants were recruited and selected 

 When, how and where the research was conducted 

Findings 
 State the overall findings, followed by specifics. 

 Include participant quotes (or links to video) 

Analysis and Recommendations 
 Item 1 found through analysis 

 Recommendation 1 

 Item 2 found through analysis 

 Recommendations 2 
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Action Items 
 Action Item 1 

 Action Item 2 

Other Considerations 
 Consideration 1 

 Consideration 2 
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Appendix B: Example Focus Group 
Moderator Guide 
 

I.  INTRODUCTION 

1. My name is _______________ and I’m the moderator today. 

2. The purpose of this discussion is to talk about __________.  I’ll be asking your opinions and your 
experiences.   

3. I am an independent market research consultant.  I don’t work for any particular company and I don’t 
have anything to sell.  I travel all over the country and talk to people like you about products, services 
and ideas. 

II. GROUND RULES 

1. This session will last about 1½ hours. 

2. This session is being audio taped and after the first few minutes I won’t be taking notes. 

3. Observers are present.  Notes may be sent in. 

4. There are no wrong answers in marketing research; we are looking for different points of view.  I want 
to know what your opinions are. 

5. Everyone needs to talk but each person doesn’t have to answer each question. 

6. Please talk one at a time and in a clear voice, avoid side conversations.  It is distracting to the group 
and I don’t want to miss any of your comments. 

7. Exchange points of view with each other – you don’t need to address all answers to me. 

8. Does anyone have any questions before we begin? 

9. This is a non-smoking session. 

10. Please turn off all cell phones and pagers. 

III. BACKGROUND (5 minutes) 

1. Please take the first few minutes to get to know the person seated next to you.   

2. I’m going to ask you to introduce him/her to the group. I’d like you to tell us something about that 
person such as their interests and hobbies, if they have a family, and how long they have lived in the 
area. 

IV. Previous Experience - General (10-15 minutes) 

1. Why did you decide to use ______________________?  

2. How long have you been a _____________________customer?   

3. Do you have experience with similar products? Which ones? 

4. Why do you have multiple products? 

5. Has anyone switched from one company’s product to one from another company?  What caused you 
to switch? 
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V. Previous Experience- Specific (30-40 minutes) 

1. How knowledgeable do you consider yourself regarding this company?  What types of products do 
they offer?  Do they offer anything unique? 

2. What is the image of this company?  What reputation does it have?  What are some of its 
competitors?  What image and reputation do they have? 

3. What do you value most about being a ___________________customer? 

4. Overall, how satisfied are you with the service you receive?  

5. Would you recommend _____________________to others? Why or why not? 

6. How loyal do you consider yourself to______________________?  What could they do to make you 
more loyal? 

7. Is there anything that would encourage you to use other products from the same company? (Probe 
with specific products.) 

8. How many of you use the online resources available from this company?  If not, why not?  (Probe: 
with specifics of known online resource issues.) 

VI. COMMUNICATION (5 -10 minutes) 

 

1. Where do you get information about the product? 

2. How well does _________________communicate with you? 

3. What’s the best way for the company to communicate with you? 

VII. ADVERTISING (20 minutes) 

 

1. Have you seen any advertising for_________________?  What type of advertising have you seen? 

2. Review communication materials. 

3. What do you like about this ad?  Is there anything you dislike? 

4. Is it memorable?  Does it seem credible? 

VIII. FALSE CLOSE  (5 minutes) 

Thank you for your comments and your time.  This has been a valuable session.  Focus groups are one 
technique that assists market researchers in satisfying customer needs.  Thank you again. 
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